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 Smart Pentamino
Smart Pentamino is a software imitation of a logical table game. The aim of the game is to 
assemble a picture of a given form, using 12 unique elements of pentamino, each of 5 
squares. A player can assemble pictures, get hints (in case of difficulties) or see all the 
solutions. One can draw up pictures by oneself and group them into libraries. For any picture
the software can find all the solutions pretty quickly.



 Menus
For information about Smart Pentamino menu commands, choose a menu topic.

File Menu
Puzzle Menu
Mode Menu
Help Menu



 File Menu
Use the File menu to open and save new or existing player files and libraries, and to display 
player statistic.
The commands on the File menu are:

Select Player Creates a new or loads an existing player file
Player Solutions Displays the Player Solutions dialog box
New Library Creates a new library
Open Library Loads an existing library
Save Library Saves the current library using its current name
Save Library as Saves the current library using a new name
Manage Library Saves the current library using a new name
Exit Saves the current library and exits Smart Pentamino



 Puzzle Menu
Use the commands from the Puzzle menu to work with board and puzzles at library.
The commands on the Puzzle menu are:

Test Board State Tests elements on the board to corresponding one of solutions of 
puzzle

Puzzle Solutions Displays the Puzzle Solutions dialog box
Select Puzzle Displays the Select Puzzle dialog box
Clear Board Clears the board from elements of pentamino
Center Figure Moves figure to center of the board    (enabled in the Edit mode 

only)
Board Size Sets size of the board (enabled in the Edit mode only)



 Mode Menu
Use the commands from the Mode menu to select the Play or the Edit mode.
The commands on the Mode menu are:

Play Sets the Play mode
Edit Figure Sets the Edit mode



 Help Menu
Use the Help menu to access the online Help system, which displays in a special Help 
window.
The commands on the Help menu are:

Contents Opens the Smart Pentamino Help file
About Displays a copyright and version number for Smart Pentamino



 File | Select Player
Choose File|Select Player to display the Select Player dialog box.

Select Player Dialog Box
Use the Select Player dialog box to load an existing player statistic file into Smart Pentamino.
If you enter the name of a file that does not exist, Smart Pentamino creates a new player 
statistic file.



 File | Player Solutions
Choose File| Player Solutions to display the Player Solutions dialog box.

Player Solutions Dialog Box
Use this dialog box to view the player statistic. This statistic includes all puzzles and all them
solutions which are found by current player.

Puzzles: m/n
m - number of the current selected puzzle
n - total number of all puzzles resolved by player

Player Info Button
Click this button to display the Player Info dialog box

Merge Button
Click this button to display the Merge Solutions from Player File dialog box

Solutions Button
Click this button to display the Puzzle Player Solutions dialog box



 Player Info Dialog Box
Use the Player Info dialog box to changing infomation about player statistic. Smart 
Pentamino stores you changes in the player statistic file when you choose the OK button in 
this dialog box.

To open this dialog box,
Click the Player Info button in the Player Solutions dialog box.



 Merge Solutions from Player File Dialog Box
Use the Merge Solutions from Player File dialog box to add all statistic to current player 
statistic from another file. Smart Pentamino stores you changes in the player statistic file 
when you choose the OK button in this dialog box.

To open this dialog box,
Click the Merge button in the Player Solutions dialog box.



 Puzzle Player Solutions Dialog Box
Use the Puzzle Player Solutions dialog box for displays all solutions of the current puzzle 
which are found by player.

To open this dialog box,
Click the Solutions button in the Player Solutions dialog box.



 File | New Library
Choose File| New Library to create a new Smart Pentamino library.



 File | Open Library
Choose File|Open Library to display the Open Library dialog box.

Open File Dialog Box
Use the Open Library dialog box to load an existing library into the Smart Pentamino.



 File | Save Library
Choose File|Save Library to store the current library using its current name.
If you try saving a library that has not been previously saved, Smart Pentamino opens the 
Save Library as dialog box, where you enter the new file name.



 File | Save Library as
Choose File|Save Library as to display the Save Library as dialog box.

Save Library as Dialog Box
Use the Save Library as dialog box to change the current library name or to save the library 
in a new location. If the file name already exists, Smart Pentamino asks if you want to 
replace the existing file.



 File | Manage Library
Choose File|Manage Library to display the Manage Library dialog box.

Manage Library Dialog Box
Use the Manage Library dialog box to manage a current library. This dialog displays all 
puzzles of the current library. Each puzzle has a name and brief statistic information which 
consists from amount of founded solutions and average difficulty of a solution search.

Puzzles: m/n
m - number of the current selected puzzle
n - total number of all puzzles in the library, limited by 24

Library Info Button
Click this button to display the Library Info dialog box

Merge Button
Click this button to display the Merge Library dialog box

Calculation Button
Click this button to display the Puzzle Solution dialog box

Rename Button
Click this button to change the name of the current puzzle at library.

Add
Click this button to add a new empty puzzle at library.

Del
Click this button to delete the current puzzle from library.

Duplicate
Click this button to make copy of the current puzzle at the end of library.

Move to prev
Click this button to move the current puzzle to previous position at library.

Move to next
Click this button to move the current puzzle to next position at library.



 Merge Library Dialog Box
Use the Merge Library dialog box to add all puzzles and all their solutions to the current 
library from another one.

To open this dialog box,
Click the Merge button in the Manage Library dialog box.



 Calculation Puzzle Solutions Dialog Box
Use the Calculation Puzzle Solutions dialog box to display and calculate all solutions of the    
puzzle(s) at library.

To open this dialog box,
Click the Calculation button in the Manage Library dialog box.    
Use scroll bar to selecting of required solution.

Calc Button
Click the Calc button to find solutions of the puzzle(s) by computer.

Clear Button
Clears all solutions of the current puzzle.

Puzzle Statistic
Displays some information about the puzzle and its solutions.

Options What It Displays
Solution: m of n m - number of the current solution

n - total number of solutions of the current puzzle
Library name the name of current library
Puzzle name the name of selected puzzle
Puzzle: m/n m - number of the selected puzzle

n - total number of all puzzles in the library
Status: m the status displays current condition of calculation.

m - amout of founded solutions
Difficulty Difficulty of all solutions search by computer
Average Average difficulty of solutions search by computer

Calc options
Check Box When Checked
First solution only Calculates only first solution of the puzzle(s).
All puzzles Does calculation to all puzzles of the current library.

Board Update Options
Option Effect
Every solution Displays every completed solution only.
Always Displays every calculated step (every placing and removing of 

pentamino elements).



 Library Info Dialog Box
Use the Library Info dialog box to view and change information about the current library.

To open this dialog box,
Click the Library Info button in the Manage Library dialog box.



 File | Exit
Choose File|Exit to saves the current library and then close Smart Pentamino.
If you exit Smart Pentamino before saving your changes at library, Smart Pentamino asks 
you if you want to save them.



Puzzle | Test Solution
Choose Puzzle|Test Solution to test all elements on the board to corresponding one of 
solutions of the puzzle.



Test Solution Message: Figure is invalid.
The cages number of the figure is not equal 60. This figure can not have a solution.



Test Solution Message: Puzzle board is empty. Please place 
elements to the board.
There are nothing of pentamino elements on board for test. But the figure is correct. You 
may place elements to the board and check its positions for corresponding solutions of the 
puzzle now.



Test Solution Message: Puzzle board contains out of figure 
elements.
Some elements on the board is out of figure. This is not a solution, of course!



Test Solution Message: Puzzle board contains invalid elements.
The figure does not have a solution because some groups of cages not short-dated by 5.



Test Solution Message: Puzzle is not full calculated. Please calc 
puzzle.
The solutions of the figure is unknown. You must calculate the all solutions of the puzzle at 
first to use Puzzle|Test Board State help. Use Calculation button in the Manage Library dialog
box to calculation all solutions.



Test Solution Message: Your solution is invalid.
Some elements on the board are place on incorrect positions. You must move them to 
another positions if you want to find a solution of the puzzle.



Test Solution Message: You solution is correct.
All elements on the board corresponds one of solutions of the puzzle. You is on a right way!



 Puzzle Solutions Dialog Box
Choose Puzzle| Puzzle Solutions or click the Solutions button in the Select Puzzle dialog box 
to display the Puzzle Solutions dialog box.

Puzzle Solutions Dialog Box
Use the Puzzle Solutions dialog box to display all solutions of the puzzle(s) at library.



 Puzzle | Select Puzzle
Choose Puzzle|Select Puzzle to display the Select Puzzle dialog box.

Select Puzzle Dialog Box
Use this dialog box to view the library. Library includes all puzzles and all them solutions 
which are found by computer. Each puzzle has a name and brief statistic information which 
consists from amount of founded solutions and average difficulty of a solution search.

Puzzles: m/n
m - number of the current selected puzzle
n - total number of all puzzles in the library

Library Info Button
Click this button to display the Library Info dialog box

Solutions Button
Click this button to display the Puzzle Solution dialog box



 Library Info Dialog Box
Use the Library Info dialog box to view information about the current library.

To open this dialog box,
Click the Info button in the Select Puzzle dialog box.



 Puzzle | Clear Board
Choose Puzzle|Clear Board to remove all elements of pentamino from the board.



 Puzzle | Center Figure
Choose Puzzle|Center Figure to move figure to center of the board.



 Puzzle | Board Size
Choose Puzzle|Board Size to set size of the board. The size of the board may be 24x24 or 
32x32. You may use this choice in the Edit mode only.



 Mode | Play
Choose Mode|Play to set the Play mode. You may set elements of pentamino on the board, 
move, rotate and remove its from the board.



 Mode | Edit
Choose Mode|Edit to set the Edit mode. You may edit a figure by use a mouse. Use left 
button to draw, right button to clear figure points.



 Help | About
Choose Help|About to display the About Smart Pentamino dialog box.

About Smart Pentamino Dialog Box
Use About Smart Pentamino dialog box to displays copyright and version information, for get
Registration Information and for display Register Dialog Box.



 Register Dialog Box
Use the Register dialog box to register shareware version of Smart Pentamino.

To open this dialog box,
Click the Register button in the About Smart Pentamino dialog box. This dialog box is 
availible in unregistered version only.



 Registration Information
    This program is released as shareware.
    The shareware version is full functional, but does not allow to use a puzzle 
    library contained more than 3 puzzles.

    If you want to register your copy of Smart Pentamino pay $10 in U.S. funds 
    to the authors by any ways which described below.

    Registered users will recieve registeration code which allows to use any 
    puzzle libraries.

 To register online with your credit card, go to: 
        https://www.setsystems.com/cgi-bin/buy-pentamino

 To more information see readme.txt.



 Game Field
Choose the Game Field in the Contents of Smart Pentamino Help to get this information.

Game Field
The Game Field included the Info Panel, the Play Board, the Variants and the Store.

Info Panel
Shows information at the top of the Game Field that help you use Smart Pentamino. Provides
some statistics which describe below:

Library
Displays the name of the current library.

Player
Displays the name of the current player file.

Puzzle
Displays the name of the puzzle at the Play Board.

Status
Displays the current mode and some following information:

Play, n/m
n - the number of puzzle solutions founded by user
m - the total number of puzzle solutions, if not all solutions are found by computer 
then question mark (?) place at right of number

Edit, n/m
n - the number of squares at figure
m - the number of squares which must be at any figure

Play Board
Use the Play Board for solve puzzle and edit figure.

Variants
Use the Variants to select necessary variety of the pentamino element.

Store
Use the Store to get necessary pentamino element for arrangement at the Play Board and 
for store spare pentamino elements.



 Control
Use mouse to drag and drop pentamino elements over the Play Board, from the Store to the 
Play Board and back.
Use left mouse button to put down pentamino element on the Play Board or on the Store.
Use right mouse button to select necessary variety of the pentamino element in cycle order 
or Shift+right mouse button for back cycle order.
Use Ctrl+mouse to work with pentamino elements in the Edit mode.




